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DESCRIPTION 

An introduction to Inventor and the beMatrix Plugin to efficiently create stand designs and more. 

LEARNING OBJECTIVES 

• Learn how to set up Inventor to work with the library and all the automated tools 
• How to start and manage projects 
• The beMatrix Library 
• Custom made parts based on library parts 
• Custom made parts from scratch 
• Calculate Connectors 
• Review and change automated connections 
• 2D Plans 
• Placing Panels 
• Rendering 
• Export your design 
• Tip & Tricks: Ideal and structured ways of working 

SKILL LEVEL 

A basic knowledge of Inventor should be expected such as placing and manipulating parts and 
assemblies. 

ABOUT ME 

My name is Kevin Hendrickx, I’ve been working as a CAD Designer at beMatrix since 2018. During this 
time, I’ve made about 2000 technical drawings for clients all over the world. Most of you have probably 
already been in contact with some of the drawings that I’ve made. 

Besides designing projects, I also create all the drawings for custom made parts which are either 
produced by our own production facility or purchased at local suppliers. In both cases highly detailed 
drawings are required to make sure that all parts are made to the required specification, tolerance, 
functionality and stability. 

Our number one concern is to always provide our clients with a design which matches their idea as 
close as possible, but still make sure that everything is 100% stable and safe to build. We try to think 
along as much as possible on how to build and try to foresee any problems that might arise. 

If you have any questions after this session or need help and assistance, feel free to contact me. 

 

Let’s go! 
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Inventor Setup 
Installing Inventor 
At the moment of writing beMatrix has a library which is compatible with Inventor 2024. We generally 
keep using this library for 2 years before updating to the latest version available of Inventor. When we 
update our library the current users will get a notification that an update is recommended. 

When purchasing an Autodesk Inventor license, be it standalone or included in the production suite, 
you should have the ability to choose which version of Inventor you wish to install up to 3 versions 
back. 

 

It’s possible to have multiple versions of Inventor installed on 1 machine, but we highly recommend to 
not do this as different version might create conflicts. 

The beMatrix plugin can only be installed for 1 version at any given time. 

Please follow the installation instructions provided by Autodesk for the installation of Inventor on your 
machine. 
Autodesk Inventor Professional Help 

If you require any help installing the Autodesk software we recommend contacting the Autodesk 
Customer Service. 

  

https://help.autodesk.com/view/INVNTOR/2024/ENU/?guid=GUID-55E8C668-C8C9-481A-BC54-F2C2125D8624
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Installing the beMatrix plugin 
It’s possible to request our beMatrix plugin from our website. https://bematrix.com/eu/en/becad-
inventor 

Our plugin in completely free and gives you access to a synchronized beCAD library in the cloud. This 
library is constantly updated with our latest items as well as preset assemblies containing different 
parts already in the correct position. 

Using our plugin will also enable you to calculate connectors automatically just like on the beCAD 
Online tool. 

Next to the automated placement of connectors there is also a wide range of automated functions that 
will assist you to generate designs more efficiently, correctly and quickly. 

To install the plugin, do the following steps: 

- Startup Inventor for a first time and press CTRL + F11 to trigger the installer for the VBA 
Plugin needed to install the beCAD Inventor plugin. 

- Execute the .exe file that you received from beMatrix by mail. 
- After the installation, check if the following folders have been created at 

C:\Users\[Username]\beMatrix 

 
- Startup Inventor and you should receive a pop-up. Unblock the following 2 Add-In’s 

o beMatrix File Manager 
o Inventor Automation 

Setting up the Project files 
- Go to Projects, where a 01 PROJECTS 2024 should have been created already. 

 
- Check if the appearance and material libraries are correct 

 
 
 
 
 
 
 
 

https://bematrix.com/eu/en/becad-inventor
https://bematrix.com/eu/en/becad-inventor
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If required, you can also add Frequently Used Subfolders to have shortcuts to specific paths in the 
library 

 

Setting Up The UI 
In order to speed up your efficiency it’s very handy to have several commands and features in fast 
accessible locations. It’s highly recommended to customize the toolbar, marking menu and hotkeys to 
improve how fast you can build your designs. 

Go to the Tools tab and choose Customize 

 

Again click on Import 
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In the window that pops up, browse to the folder included in the library: 

C:\Users\[Username]\beMatrix\beCAD 2024\99 Templates\20_Config 

and select the beCAD_Customize_Ribbon_KeyBoard_MarkingMenu.xml file to import the settings file 
containing all the UI settings to maximize the efficiency with the beCAD Add-In. 

 

Setting File Locations 
For the functionality of several beMatrix specific commands we need to direct Inventor to the specific 
folders. 

Use the SetFileLocation button 

 

First select the location of the beCAD folder: 

C:\Users\[Username]\ beMatrix\beCAD Library – INTERNAL\beCAD 2024 

  

After this select the folder where you will store your projects: 

C:\Users\[Username]\ beMatrix\01 PROJECTS 

Overview of hotkeys: 

Q Gridsnap 
W Change Element 
CTRL + SHIFT + X Flip X-Axis 
CTRL + SHIFT + Y Flip Y-Axis 
CTRL + SHIFT + Z Flip Z-Axis 
TAB Create Subassembly 
SHIFT + TAB Move to Subassembly 
F6 Home View 
M Measuring Tools 
ALT + V Toggle Visibility 
ALT + T Toggle Transparency 
CTRL + H Replace Selected Part 
CTRL + SHIFT + H Replace All Occurrences Of Selected Part 

 

- Q : Gridsnap 
- CTRL + X : Flip X-Axis 
- CTRL + Y : Flip Y-Axis 
- CTRL + Z : Flip  
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Unless you are using a remote project folder (on a network drive) select NO when asked: 

 

The region select should be Belgium 

 

This should conclude the initial setup of Inventor for beCAD. To make sure that everything is working 
as it should we will test it using a dummy project. 

Starting a Test Project 
Startup Inventor and try the New Project button 

 

You should see the following pop-up asking to select the client. If the client does not yet exist use the 
Make New Folder option to create a new folder for the new client. 
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If all went well Inventor is now completely setup for use with the beCAD plugin. 

Troubleshooting 

- if the NewProject button isn’t visible, this means that Inventor can’t find the VBA file 
containing the macros or the VBA plugin isn’t installed yet. Please check if you have 
the following path in the application options under the Default VBA project line 

C:\Users\[Username]\ beMatrix\beCAD 2024 for clients\99 
Templates\05_Default VBA project\beMatrix 3.1.ivb 

- If instead of the Browse for Folder popup, you receive the following message 

  
please make sure that the 01 PROJECTS project file is active. 
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Starting A New Project 
Now that everything is set up, it’s time to begin a project. We do this by using the New Project button. 
This will start a macro that will ask and store the basic information for your design. 

 

Inventor will ask you to choose the client or create a new one and then give an (optional) order number 
and project name. 

  

After this a new file will be created under the client's folder in a new subfolder by the [order number] 
[project name] syntax. This will make sure that each project will get its own unique subfolder to keep 
things organized. 

The new file will open in Inventor where a floor will be present. We can immediately change the floor 
size to the dimensions that are available for the project. 

 

One the floor is specified we can begin setting up frames. 
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The beMatrix Library 
Our library is organized in several subfolders some containing even additional subfolders. Take your 
time to explore this library and get acquainted with it. It might very well be that we have some 
connectors and parts that you have never been aware of. 

All frames and parts are possible to be placed in 3 ways. 

- Using the beCAD library in Inventor 
- Drag and dropping the files from an windows explorer window 
- Using the “Place Component” command in Inventor 

The main folders are: 

- 10 FRAMES 
- 20 LIGHTBOXES 
- 30 AV SOLUTIONS 
- 40 PARTS 
- 50 INFILLS 
- 60 LIGHTING 
- 70 ACCESSORIES 
- 80 IZI-RANGE 
- 100 XTREME SOLUTIONS 
- 110 POP SOLUTIONS 
- 120 KICK-OFF 

10 FRAMES 

This folder contains 2 divisions, our old b55 range and the standard b62 range. In Inventor we will 
always be using the b62 frames. 

The b62 folder is further split up in to all our different types of frames 

- 10 – STRAIGHT FRAMES 
- 20 – DOOR FRAMES 
- 30 – CURVED FRAMES 
- 40 – PERFECT CORNERS 
- 50 – FRAME PROFILES 
- 60 – GLASS FRAMES 
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Each of these folders contain several parts. Some of these are single parts, other are iParts containing 
all standard dimensions within them in a table. When placing these you will get a popup asking the 
required size of frame. 

  

Once a size is chosen, the iProperties of that part will update to match the frame in your design. This 
will result in correct BOM (Bill of Materials) that you can utilize to place your order at beMatrix. 

As you can see, we do not take in account different color finishes to our parts. All frames and profiles 
are in an ECO appearance (or their standard RAL color). If required you can always override the 
appearance of parts in Inventor, but we’ll come back to that later in our training. 

20 LIGHTBOXES 

This folder contains all the different type of lightboxes that beMatrix has. 

- 10 – SIDELED LIGHTBOX 
- 20 – BACKLED LIGHTBOX (no longer sold) 
- 30 – LIGHTBOX PROFILES 
- 40 – LIGHTBOX PARTS 
- 50 – MOTIONSKIN (no longer sold) 

We have both iParts that can be used for standard lightbox setups and sizes, but also iLogic parts that 
can be placed when you need more control over the dimensions, type of profiles, type of holes, …  

30 AV SOLUTIONS / LEDSKIN 

These folders contain all audio-visual components such as our LEDskin and the new beTV. 

- 10 – LEDSKIN 
- 20 – BETV 

40 PARTS 

The parts folder is without doubt the biggest and most used folder with Inventor. The folder contains 
pretty much all different beMatrix connectors, profiles and tools used to connect and finish your 
frames. 

It’s here that the biggest difference lays between the beCAD online tool and the Inventor Plug-in. 

While in the online tool you can only calculate the connectors based on rules, but you cannot 
manipulate or change them. In Inventor you are completely free to add, remove, change or replace 
connections as you like. Keep in mind that doing so you might comprise the structural stability of your 
design. So always take care to closely review all connections before releasing your design. 

Mainly used subfolders are: 

- 10 - COVER PROFILES 
- 20 – CORNER PROFILES 
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- 60 – D30 STEEL PINS 
- 70 – D30 CONNECTORS 
- 100 – BASE PLATES 
- 160 – END PIECES 

50 INFILLS 

The infills folder contains the standard infill panels for our b62 system. There are panels available for 
straight and curved frames, doors, iZi Range, Double Deck, POP-Out, …  

Textiles are not (yet) available. 

60 LIGHTING 

Our SAM, big SAM and CEE lights are all available in the lighting folder as well as their accessories to 
place them on frames or profiles. 

Our Track light system is also included in this subfolder. 

70 ACCESSORIES 

Accessories contains some auxiliary items such as trolleys or HPL panels. 

80 IZI-RANGE 

Our iZi-Range eco system containing all the different items with or without the use of panels. 

100 XTREME SOLUTIONS 

Xtreme Solutions consists of 2 categories. The beTruss system and the Double Deck. 

110 POP SOLUTIONS 

Both our indoor POP-In as the outdoor POP-Out are located in these folders 

The POP-In subfolder also contains the Glass frame SET’s which are used to create large glass walls. 

120 KICK-OFF 

The outdoor Kick-off folder contains our UnderCovr. 
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Building your project 
When building your design there are some important rules to take into account. Always make sure that 
the 01 PROJECT is active, this will ensure that the correct libraries and workspaces are being used. If a 
different project is active, it will not be possible to create a new beMatrix design. 

Once we made sure that the correct 
project is active, we use the New Project 
button to get started. 

 

 

 

 

 

 

A pop-up will appear asking you to 
select the client's folder. If you are 
creating a project for an existing client, 
choose the name of the client. If it’s a 
new client, create a new folder under the 
01 PROJECTS folder with the client's 
name. 

 

 

 

The next pop-up will ask us some details 
of the project, fill in the Order No., 
Project name and optionally a Project 
Manager. Once you’ve filled in the details 
click on the Done button. 

 

 

 

 

 

The beCAD plugin will create a new project assembly based on the details we’ve entered with the 
following syntax: [ORDER NO] [PROJECT NAME].IAM 

It will also create a new subfolder under the client's folder to keep your files organized and structured. 
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Once the assembly has been created, 
we will be given a floor surface and 
another pop-up asking us how large the 
booth surface is. This floor will serve as 
a guideline to remain within your 
allocated space. 

 

 

 

You can choose any size from the 
dropdown boxes next to Width and 
Depth, once you click ok the floor will 
update to the given dimensions. 

 

 

 

 

 

We can now start by placing frames on the surface of the floor. Important is to keep in mind that the 
XY plane of the main assembly will be used as the reference for the engine to calculate the 
connections. So please pay attention to the positioning of the frames. The floor itself is constraint in 
place to prevent it from accidentally being moved from the XY plane. 

To place frames there are 3 ways: 

1. Using the beCAD library accessible from within Inventor 
2. Drag and drop from a windows explorer window 
3. Using the Place Component command from Inventor 

When unfamiliar with the beCAD library we recommend using the first option. This will give 
you an organized library based on groups and families. All parts have a convenient 
thumbnail to make it easier to identify the different parts. Double click a part to place it in 
your assembly. 
When you double click apart from the beCAD library, it will automatically download the most 
recent model from the cloud and will store it in your local library. From then on you can 
always use the local version or keep using the library to constantly update your parts. 

Some parts, such as frames, have multiple variants to choose from when placing. You can 
for example choose the dimension of the frame before placement. 

Let’s place our first frame. 
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For this training I’ll be using the Place 
Component command from Inventor. 
Initially you will need to select the 
frames and parts from the beCAD library 
to have them available on your machine. 

Choose the 606 ++++ ++++ 30_All 
Dimensions.ipt file. 

 

 

 

We will receive another pop-up asking 
us which dimension we would like to 
place. Choose the 992 x 2480mm 
frame. 

The frame in the window will change to 
the specified dimension. Right click and 
choose in the marking menu to rotate 
the frame 90° along the X-, Y- or Z-axis. 
You can use the triad on the centre of 
the frame as a reference. 

Rotate the frame 90° along the X-axis 
to position in vertical. 

 

Place the frame roughly where you want 
to place it and finish by right clicking 
and OK. 

 

 

 

 

 

 

We now placed our first frame, but still have to position it more accurately on to the floor surface. We 
will use Grid Snap to precisely move our frames and parts into the correct position. 
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Right click the frame and choose Grid 
Snap (hotkey = Q) 

 

 

 

 

 

 

 

With the Grid Snap command active, 
zoom in on the frame an notice that 
there are several options on where to 
select your frame. 

You can use end point, midpoints, 
edges, edge axis vectors, work points,… 
each type of reference will give you 
several options on how to continue. For 
now, we will select the corner endpoint 
to position the corner of the frame on to 
the corner of the floor surface. 

 

 

With Grid Snap you are able to quickly position one or more component(s). When 
starting the command, you’ll be given the option to select points, lines, axes or 
surfaces. Depending on your selection you’ll be given one of the following options: 

- Point   

- Line   

- Axis   

- Surface   

 

Once you’ve made a movement, confirm it by right clicking and choosing OK or 
Continue 
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Select the corner of the floor and 
confirm the move by right clicking and 
choosing Continue and again choosing 
OK 

 

 

 

 

 

With our first frame set up in the correct 
space, we’ll want to quickly create a full 
wall of frames. We do this by using the 
Pattern feature. 

Select the frame and choose Pattern 
Components. 

 

 

 

In the dialogue box, first choose the 
direction of the pattern (you can use the 
edges on the floor as a quick way to 
select the X and Y directions), the 
number of occurrences and the 
distance between each occurrence. 

It’s also possible to enter formula’s in 
these parameters. 

Click OK to confirm the feature. 

 

In order to explode the pattern so each 
frame becomes an individual component 
again, right click on an empty space and 
choose Delete Pattern. 
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We can now start copy and pasting the 
frames. Use Grid Snap to place them in 
the correct spot. While using Grid Snap 
you can use the workpoints to snap to 
holes of adjacent frames. 

Remember to use the Flip X,Y,Z hotkeys 
to quickly change the orientation of your 
frames. 

Use Change Element (hotkey W) to 
change the sizes of your frames. 

 

Instead of manually placing a doorframe, 
it’s also possible to replace a standard 
992mm wide frame by a doorframe 
using 1 of the automated tools. Select 
the right frame of the little storage and 
use the PlaceDoor tool. The frame will 
now be replaced by a doorframe of the 
same height. You will also be given the 
option to rotate the door 180° if required.  

 

 

 

Let’s continue placing additional frames. 

 

 

 

 

 

 

 

Once all our frames are in place it’s time to start with the finishing of our stand. We will first start by 
placing steel covers, then regular covers, baseplates, shelves, flatscreen support and universal 
brackets. Finally we will add a ramp to the floor element. 

This is also a good time to save our work. Remember Inventor is still a program and 
can crash, make sure to regularly save your progress since Inventor has NO 
autosave or backup functionality. 
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Use the Place Component action and 
navigate to the 40 PARTS\10 – COVER 
PROFILES\ folder and select the 608 
R0496 RAL.ipt file. Again use Grid Snap 
to place it in the correct position. 

 

 

 

 

 

 

 

 

 

 

 

 

When we look at the other end of this 
arch we run in to a problem. We should 
place a steel cover here as well to make 
the arch more stable, but we do not have 
a standard part for this. 

 

 

 

 

When you need a custom made part which is closely based on a standard part it’s easiest to use the 
Create Custom tool. 

This tool will take the library file and make a local copy of it in the folder of your project. Since this is 
no longer a library file, it becomes fully editable. 

Keep in mind that when creating a custom item in this way, you are limited to what is possible to 
change. If your custom item is to different it will be better to create it from scratch. 
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Custom made parts based on library parts 
When creating a custom part based on a library part, we will first place the library part and then create 
a local custom or variant of it.  

To solve our problem with the steel 
cover, first place the standard steel 
cover, select it and use the Create 
Custom tool. 

 

 

 

 

 

In the dialogue window, enter a new part 
name for our local copy and change the 
description to specify the new part. 

 

 

 

 

 

 

After clicking OK, a local copy will be 
made and Inventor will immediately open 
the component to edit it. In this case we 
want to shorten one of the legs by 
496mm. Create a new sketch and draw 
a rectangle over the section that we 
want to remove. Use the Cut feature to 
remove the material. 

 

 

 

Do the same for the other side. 
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Now that we have placed our custom part we can start placing covers. You can quickly place covers 
by selecting frames and using the Place Covers tool. The tool will take in account already present 
covers as well as the location of the selected frame. A frame placed on the ground will receive 
different covers then a hanging frame. This is also why we first placed the steel covers, because these 
will be taken in to account when using the tool.  

Select the frames where we want to add 
covers and use the Place Cover tool. 

Note that you can select multiple frames 
even if they are not adjacent to 
eachother. 

 

 

 

 

 

There are still some places where the 
tool doesn’t (yet) place covers, here we 
will have to add the manually. 

Join the 2 covers by selecting them and 
using the Join Covers tool. This will join 
the covers and replace them by one 
part. 

 

 

 

 

Now we will add some baseplates to ensure that all the walls will be stable. We will add some 
baseplates under the left side wall and underneath the two small frames at the arch.  

We can do this by either manually 
placing the baseplates or by using the 
Place Accessories tool.  

Select Half Baseplate, click OK 
andchange the orientation if required. 

 

 

 

 

We can use the same tool to place SAM light, all kind of shelves and brackets.  
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Use the tool again to place some around 
our booth. 
Again notice that it’s possible to select 
multiple frame, but also multiple 
accessories. 

 

 

 

 

 

Once we placed our accessories it’s time to move further. 
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Custom made parts from scratch 
Since it’s possible to use Inventor as a hybrid system you are no longer limited to our parts alone. It’s 
possible to create anything from scratch using Inventor. Keep in mind that some more advanced 
knowledge is required to create these items. 

There are numerous tutorials online (YouTube, Autodesk,… ) that will help you in this process. 

For this training I will show you how to create two parts that might come in handy when designing your 
booth. 

- a wooden board to be used with the universal brackets. 
- a textile with a print applied to cover multiple frames. 

A wooden board 

We begin by creating a new part.  

 

Use an easy to recognize filename and make sure the new file location 
is within our project. 

Click OK and click on an empty space to create our new part. 

 

Create a new sketch with a rectangle 
with a 856 x 500mm size and extrude it 
with a thickness of 10mm. 

 

 

 

 

 

 

We can change the material to wood 
using the material editor and choosing 
Wood. The appearance will be 
automatically set to the default 
appearance of this material. 

If required, it’s always possible to 
overwrite the appearance by selecting a 
different one from the appearance 
editor. 
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Now our part is finish we can return to 
our project and use Grid Snap again to 
position it behind the universal brackets. 

 

 

 

 

 

 

A Custom Textile 

It’s possible to create textiles and add prints to them as well. 

Start by creating a new part in our project again. 

 

 

Create a sketch of 992x992mm and 
extrude it by 2 mm. 

It’s also possible to sketch out the shape 
of the textile and extrude it in the height. 

 

 

 

 

 

Create a new sketch on the face of the 
textile and choose Insert Image 

Place and resize the image so that it fit’s 
over the square shape. 
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Finish the sketch and choose Decal 

Select to face you want to apply the 
decal to and Inventor will automatically 
crop the image and makes it follow the 
shape of the face. 

 

 

 

 

 

Position the textile on our small lightbox 
to finish it off. 

 

 

 

 

 

 

 

Import CAD files 

Next to Inventor files which you can place from the library or create yourself, it’s also possible to 
import different CAD files, such as STP, DWG, STL,… files. 

There are numerous places where you can find and download 3D files. 

• https://grabcad.com/library 
• https://fabory.partcommunity.com/3d-cad-models/sso/ 
• https://archive3d.net/ 
• … 

I suggest trying to use STP files as these will carry the most information. 

Simple choose Import CAD Files under 
Place and select your CAD file. 

 

 

 

 

 

 

https://grabcad.com/library
https://fabory.partcommunity.com/3d-cad-models/sso/
https://archive3d.net/
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Calculate Connectors 
Now that we have finished placing our frames, accessories and custom parts, it’s time to use the 
update button to have Inventor calculate the connectors for our stand. 

This process is completely automated and will take in to account the basic rules to correctly connect 
frames depending on which type of connection is required. 

The Update tool has the exact same backbone and rules as the one available on the beCAD online 
platform. 

As with every automated process it’s very important to always review the connections and make 
changes where it’s needed. In some cases new parts and frames are not yet included in the calculation 
and therefor will also not correctly be included in the process, but rest a sure, the tool is constantly 
being updated to include these connection as soon as possible. 

Please note that custom parts that are made from scratch will never be able to be included since the 
possibilities here are endless and these take thorough review to include all the required connections. 

Custom made parts based on standard parts, will be included in the process based on their standard 

counterparts. 

 

The main rules are the following: 
- At each straight connection 2 double clamps and a 180° PIN without bolts on the 

bottom 
- At each L-connection 2x 90° PINS at the top and bottom with M8 bolts on all sides 
- At each T-connection 2x T6 PINS at the top and bottom with M8 bolts on all sides 
- All horizontal covers are to be fixed with the M8 + COVER SLIDER. Vertical covers are 

placed with the green cover clips 
- Each 3m there has to be either a return frame or baseplate depending on the height 

of the wall. Additional ballast can be required. 
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Please check all our manuals on the website for more information regarding the rules to build a safe, 
stable and strong stand. 
https://bematrix.com/eu/en/library?f%5B0%5D=downloadtype%3A372 

  

https://bematrix.com/eu/en/library?f%5B0%5D=downloadtype%3A372
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Review and change automated connections 
Once the connectors are placed, we will review the connections and take a closer look at some of the 
locations where the update tool failed to place a valid connection. 

In our design there are 2 locations where the update tool failed to place the correct connections. 

The first one is at the back of the arch. 

Here the update tool placed 4 M8 pins to 
much. The reason why is because it 
placed these based on the standard 
steelcover. In this case these are not 
needed and can just be deleted. 

The tool also placed 2x T6 PINS at the 
top of the wall, we will have to replace 
this connection by a different on to 
connect the curved frame to the 
backwall. 

First begin by deleting the unnecessary 
connectors. 

 

We will replace the T PINS by a T-
CONNECTION BASE D30 with a M8 PIN 
that will be positioned over the already 
present double clamp in the backwall. 
Keep in mind that there are multiple 
ways to solve this problem, but always 
try to look for a solution that will grant a 
strong and stable stand. 

 

 

 

At the front the Update tool placed 3 red block to indicate that it failed to place a connection in this 
area. The reason here is because the glass frame is still a very new product and not yet fully 
incorporated in the Update process at this time. 

We will connect the two curved frames 
to the glass profile by using 4 TOOLLESS 
D30-SLOT CONNECTORS. 
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Subassemblies – Creating Structure 
At this point we’ve placed frames, accessories, custom parts and calculated and review all our 
connections. 

All parts however are still placed loose in our project assembly. In order the create more structure we 
will make selections and place those parts together in 1 subassembly.  

Often used subassemblies are : 
- Backwall, 
- Frontwall 
- Storage 
- Arch 
- … 

This will divide our design up and makes it easier to create and understand the 2D drawings in a later 
stage. 

Also in big projects this helps with performance as you can work on independent subassemblies 
without having to open the full design. You can even split the work by working with multiple people 
with each in its own subassembly. 

Since Inventor is a reference based program, all changes made within the subassemblies will also be 
applied in any assembly containing these subassemblies. 

Let’s begin by selecting all the part that 
make up the backwall. In complex 
projects it can help to hide certain 
sections that would otherwise be in the 
way. 

 

 

 

 

 

Once we have the parts selected, press 
the TAB key on your keyboard. 

Enter the name of the subassembly.  

 

 

 

 

 

If you want to place the subassembly in a subfolder of the project folder, start with 
the folders name followed by a “\” and then the assemblies name.). The selected 
parts will now be grouped together. 
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Continue with the other sections. We will create the following subassemblies: 
- Backwall 
- Sidewall 
- Storage 
- Arch 
- Ground 

 

If you want to move parts from one assembly to another you can select the parts and use CTRL + TAB 
to choose a different subassembly. 
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2D Plans 
Once the 3D model is complete we are ready to start creating our 2D drawings based on these 
models. Again the reference based model is used so that any changes we make in our model, will 
automatically update in our 2D drawings. 

Before we start please double check that aside from the floor object, ALL other parts are inside a 
subassembly. 

 

 

 

 

 

 

 

Use the AutoDrawing tool to start creating the drawings. As you will notice, most of it will run 
automatically.  

The first page will be an overview of our 
design with a structure list of all the 
subassemblies. 

 

 

 

 

 

 

 

The second page is an overview page 
with a front, side and top view of our 
design. 

You can use this page to place all the 
dimensions that you need for your 
panels or textiles. 

You can also generate sections or cut-
out views on this page or drag it to a 
new sheet to have it linked to eachother. 
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The remaining pages are for each 
subassembly within the project. 

The Autodrawing tool will generate a 
view based on the subassemblies we 
created earlier, place and sort a parts list 
for that section and finally highlight all 
the connectors and smaller parts in a 
green overlay making them more visible. 

 

 

You can use these pages to place balloons identifying the frames and parts with their corresponding 
item number of the partslist. 

You can also place detailed views of parts to have a more detailed view of the connection. 

 

If you study the title section on every page, you’ll 
notice certain field are already filled in with the 
information we’ve provided at the start of our 
project. 

 

 
 

- Your name based on the name provided in the application options 
- Your clients name based on the client folder we selected at the start of the project 
- The Project name and number by the information given at the start of the project 

 

When everything is finished, use the export to PDF function to generate a pdf drawing. The drawing 
will be placed by default in the same location as that Inventor drawing file. 
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Adding Panels 
Now that we have the structural side finished, we can start looking at how we are going to finish our 
stand. 

The Inventor beCAD plugin offers you 
the ability to automatically place infill 
panels on the frames that you select. 
You can select either a single or multiple 
frames, or whole subassemblies. 

 

 

 

 

 

When using the Place Panel command, Inventor will create a new subassembly and 
place the panels according to the matching frames. 

 

After using the command, you can delete 
the panels that you do not need (for 
example to top side of a roof, or the 
inside of a storage). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you want to you can use the appearances to override the look of your panels from 
the standard white to any appearance of your choosing. It’s also possible to add 
decals over one or multiple panels. 
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Rendering 
Inventor has a basic render engine that enables you to make quick renders from you final design. 
The quality of these renders depends greatly on: 

- The materials and appearances that you use 
- The amount of time given to the render engine to produce a result 
- The level of detail in custom made or imported parts. 

To enable the rendering environment, 
startup Inventor Studio from the 
Environments tab. 

 

 

 

 

 

 

You can manage the studio lighting styles to suit your lighting and 
shadow settings 

 

 

 

 

You can create camera’s with options for perspective or orthographic view 
mode, as well as depth of field and position of camera and target. 

 

 

 

 

In the render settings you can choose the resolution, 
which view to render, and how long you want the render 
to run. 
Keep in mind that increasing these settings will result in 
much longer rendering times. 
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Please keep in mind that for more advanced renders we highly recommend using 
more dedicated software such as 3dsMax (included in the Autodesk Production 
Suite).  
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Export your design 
There are multiple ways to export and share your design. 

- Shared Views 
- Export CAD 
- Pack & Go 

Shared View 
Shared view is a cloud based service of Autodesk, where you can export your design directly from 
within Inventor. 
The upload usually takes only a couple of seconds and gives you a weblink which you can share with 
your client/colleagues. 

The link is valid for 30 days after which it gets deleted from the Autodesk server, guaranteeing that 
your design is safe and protected. 

The link can be accessed from any device that has an internet connection and web browser, this 
means that you can open, view and inspect your design from anywhere and anytime. 

To create a shared view go to the 
Collaborate tab, choose the Shared 
Views tool and create a New Shared 
View. 

 

 

 

 

 

 

Choose your options and click Share to start uploading your design.  

Once finished you can copy the link and share you design with 
however you want. 
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Export CAD 
Inventor allows you to export your design to a numerous amount of filetypes. 

To export your design choose the 
Annotate tab and then the CAD Format 
tool. 

 

 

 

 

 

 

In the dialogue window you can choose 
to which filetype you want to export. 
Most common filetypes are DWG and 
STP files. 

 

 

 

 

Pack&Go 
Pack&Go allows you to share your Inventor files with other people who have Inventor but no access to 
the beCAD library. It packages an Autodesk Inventor file and all of its referenced files under a single 
location. 
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In Autodesk Inventor, click File, Save As, 
Pack and Go. 

This will take and copy all files that are 
referenced in your project and place 
them in to one folder. You can then 
upload this folder to anyone using 
Inventor. They will then be able to open 
your project using all the parts and files 
provided in this single folder.  
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Tip & Tricks: Ideal and structured ways of working 
A Clean Working Environment 
To be able to work efficiently we like to set up our folders to show large thumbnails of the parts that 
included in the library. This makes it far easier to identify parts not only by their part number, but also 
how they look. 

To do this we need to navigate to a library folder that contains some parts. 

- Right click on some empty space and choose Customize this folder… 
- Go to the Customize tab and set the view to Video and click OK 
- Right click on some empty space again and choose View → Large Icons 
- Again, right click on an empty space and now choose Group by → Type 
- Save this view to the Video preset by going to File → Change folder and search options → 

View tab → Apply to folders →apply and close 
- Go back to the main beCAD 2024 folder and right click on an empty space → Customize 

this folder … → Customize tab → select Video and check Also apply this template to all 
subfolders  
 

Your folders should now look like this: 

 

You can now collapse filetypes so you no longer see them. 


